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1. Installation

1.1

Installation Process

Step 1: Unpack the Unit

This unit gift box contains the following items:

The unit

Quick Start Guide

Screws for disk drives (1 package)

Power cord

Warranty card

12V DC power transformer (2 bay unit)

CD with Install Wizard , Backup , Live View , and Playback
application, user manual, and quick start guide

N

Warning

The electronic components within the unit are sensitive to be
damaged from Electro-Static Discharge (ESD). Please take
precautions at all times when handling the unit or its
subassemblies.

Important

To configure the unit, you must install the software onto a
desktop/ laptop running Windows Vista, 2003, XP Professional,
or 2000.

2 bay unit (4 channels) front view

Disk Drive
_~ Drive Carrier

/‘Ix’ Drive Status LED
=#— Drive Activity LED
o o-ut Ethernet Activity

D LED

' Power button
/

A\
\

System Status LED
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2 bay unit (4 channels) rear view
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4 bay unit (8 channels) front view
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Step 2: Install Disk Drives

You can populate this unit with SATA 1.5 Gb/s or 3.0 Gb/s disk drives. For
optimal performance, install disk drives of the same model and capacity.
Your disk drives will become a RAID Volume on this unit.

1. Open the lid on the front of the unit enclosure.

2. Pull a disk drive carrier from the enclosure. See the front view figure.

3. Carefully lay the disk drive into the drive carrier, making the screw holes
on the sides of the carrier aligning with the screw holes in the drive.

4. Insert the screws through the holes in the drive carrier and into the sides
of the disk drive.

Install only the counter-sink screws supplied with the unit.
Install four screws per disk drive.
Snug each screw. Be careful not to over-tighten.

5. Reinstall the drive carrier into the unit enclosure.
6. Repeat step 2 through 5 for the other disk drive.
7. Close the lid on the front of the unit.



Step 3: Connect to the Network

Attach one end of the network cable to the RJ45 network connection.
See the rear view figure.
Attach the other end of the network cable to your Ethernet hub or
switch.

Important

which you connect the unit. You will need this information during

Z If there are multiple networks at your facility, note the network to

the setup process.

Step 4: Connect the Power

Attach the power cord from the power source to the power adapter.

. Connect the power adapter to the back of the unit enclosure. See the

rear view figure.
On the front of the unit, press the power button. See the front view
figure.

It takes about a minute to boot the unit. After fully booted:

The System Status LED turns green. See the front view figure.
The buzzer beeps one time.

Step 5: Install the Software

P wnN e

Insert the CD into your CDROM.

Double-click Setup.exe to begin installation.

Click the Next button to go on installation.

Click the “I accept the terms of the license agreement " option, and
then click the Next button.

Insert your “User Name” and “Company Name” then click the Next
button.

Select the setup type, and then click the Next button.

Click the Install button to proceed with installation.

When above-mentioned installation processes are finished, a final
installation screen appears. Click the Finish button to close the installer.



Step 6: Setup the Unit

The software Install Wizard performs the setup procedures on your unit.
After the procedure, you can begin using this unit.

1. Go to Start > NUUO NVRmini > Install Wizard.

2. This program will show the default language setting and initiation mode.

3. Choose preferred language and initiation mode, and then click the Next
button.

£ HYRmini Setup Wizard =3

Welcome to HYRmini Setup Wizard.

Initiation Mode
(%) Express Mode

(O Advance Mode

Click NEXT to continue.

NEXT == ” CANCEL

Express Mode : you don’t need to set the date, time, network settings,
and RAID level. (After step 5, jump to step 9 directly.)

Advance Mode : you need to set your specific date, time, and
network settings.

4. Install Wizard program will search all the units on the internet right now.
Choose one of them, and then click the Next button.



"> NYRmini Setup Wizard

Digcovering HUUO HYRmini. N
Please choose a HUUO HYRmini from the list. |

c

aya_dbay_james

192.168.3.31
wv2040_703137 192.168.3.123 |NVQD4D =
aya_2bay_pressur 192 168343 |NV2040
wya_Thay_jay 192 168.3.33 [Hr72040
aya_dhay_tony 192.168.3 34 |NV4DBD b
< | >
Click NEXT to continue.

<< BACK | WEXT -~ [ CANCEL

5. Insert the password, and then click the OK button.

CoX

rIP Address:192.168 .3 .45

Administrator ; | |

Password | |

Note

The default password of Administrator is “admin”.

6. Set the time zone, date, and time, and then click the Next button.
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2% N¥Rmini Setup Wizard

Setting time zone, date and time.
Please choose your time zone, date and time | \ !
from the dropdown menus. ,

Time Zons | (GMT+8 Taiped, Beifing, Perth, Singapors, Hong Kong, Ulsen Batsar |
Vear |2008 |
Month |6 |
Date |6 |
Time |12 v| 105 v (11 (v

Click NEXT to continue.

[ «Back |[mEXT - ]| cancEL

7. Make the network settings, and then click the Next button.

2 N¥Rmini Setup Wizard

Making Hetwork Settings

Please choose a method of making network settings.

(%) Obtain network ssttings antomatically from DHCF server or wizard.

() Make network settings manually.

Click NEXT to continue.

<< BACK | WEXT -~ [ CANCEL

Obtain network settings automatically from DHCP ser ver or

wizard : apply the settings, such as IP, netmask, gateway, DNS which
are generated from DHCP server.

Make network settings manually : make your specific settings.

8. If you need to set a new disk(s), check the “Create new storage ” option.
After checking, click the Next button.

11



£ NYRmini Setup Wizard

Protecting Your Data. \
Please choose a protection function for your storage.

[] Create new storage

The Wizard iz configoring your NV Rmini.

Click NEXT fo continue.

<< BACK || NEXT - || CANCEL

Data Protection : set the RAID level to RAID 1 (2 bay). Set the RAID
level to RAID 0 (4 bay).

Maximum Capacity : set the RAID level to RAID 5 (2 bay). Set the
RAID level to RAID 0 (4 bay).

9. Review your settings. If the settings are correct, click the Finish button
to finish this setting process.

#: N¥Rmini Setup Wizard

Reviewing your settings \
Please check data on the list.

Current Settings

Parameter Value
MW Rinind Name aya_dbay_pressur
Time Zone GMT+8
Diate! Time 2008464 12:05:11
IF Address 192.168.1.2
[torage Tvpe TTnchange
User Name admdn

EBACK to change settings. Click FIMISH to start system initistion.

«<BACK || FNSH || CANCEL

Caution
Once completing the settings of the unit, the unit will start

working. In order to let your unit be stable, do not pull any disks
out when the system is running.
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1.2 Definitions of LED Status

System Status LED

Green Red Amber
Definition Healthy Fall Critical
Drive Status LED
Green Red Amber Dark
Definition Healthy Fail Rebuilding Without disk

Drive Activity LED

Blink No blink
Definition Activity No activity
Ethernet Activity LED
Green Blink
Definition Link Accessing

13




2. Settings

After setting the unit, login the system by inserting its IP in the browser.
When connecting, insert the user name and password, and then begin

using this system.

~nuuo

NUUO Network Video Re:

— |
—
[ coon |

2008 NUUO Technology Inc. All rights reserved.

order

There are four main functions of this unit: settings, live view, playback, and

logout. They will be shown on the top of the page.

2.1 Set Cameras
2.1.1 Add UPnP Cameras
Open Internet Explorer and login the unit.

Click IP Camera/ Camera Settings .
Click the Camera Search tab.

P wbhPE

Camera Setting

o=l Rl Camera Search

14

Click the Search button to search UPnP cameras.




5. The system will list all the available cameras at this moment. Click the
icon # to add this camera into your camera list.

Camera Setting

Camera

. Search

IP Addr
IP Address

Model MAC

Mac Address

YVendor

Vendor Model Name *

6. After clicking the icon ", the camera setting page will pop-up. Click the
item which you want to add a camera.
7. Insert the camera name, user name, and password of the camera.

Settings | Live view | Playback | Logout

anddﬂ'(:amera

Camera |
MName

Address | 192.168.2.23 Part

dministrator
MName

Addto
channel

Password

Protocol |HTTP

Vendor Model |Model Name

e Current Camera Settings

Camera Mame

Address

Vendor Model

Channel

—none —

—none —

—nong —

—none —

—none —

—none —

—naone —

—none —

—naneg —

—none —

—none —

—none —

—none —

— none —

Note

Some cameras will limit the login authority to the administrator. In
this condition, you need to change the login user name and
password to the administrator’s to login those cameras.
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8. Click the Add button to add it.
9. After clicking the Add button, the updated camera list will be displayed
in the Camera Setting tab.

Channel Camera Name Address Wendor
1 Location 1 192.168.1.192 Vendor

—none —

—none —

—none —

—none —

—none —

—none —

—none —

10.Repeat step 5 through 8 to add other cameras in your list.

2.1.2 Add Cameras without UPnP Function

1. Open Internet Explorer and login the unit.

2. Click IP Camera/ Camera Settings .

3. Click the Camera Settings tab, and the camera list will be displayed on
the bottom of the page.

4. Click the item which you want to add a camera.

Camera Mame | Vendor

—none — —none —
| |

5. Insert the information of this camera on the top of the page.

16



Camera Settings

Camera Search

&) Camera Settings
Camera Name | |
Address | | Port |8[] |
User Name | | Password | |
Video Channel Pratocol TCP  UDP  HTTP
7 — Sy — arT——

Camera name : name this camera.
Address : the IP address.

Port: the transmission port.

User name : login user name.
Password : login password.

Camera Channel : the number of cameras that video server supports.

Protocol : data transmission protocol.
VVendor : camera vender name.
Model : camera model name.

Note

Some cameras will limit the login authority to the administrator. In
this condition, you need to change the login user name and
password to the administrator’s to login those cameras.

6. Click the Save button.

Save: save the information of this camera.

Reset: return to the latest saved settings of the selected camera.
Auto Detection : after inserting IP address, port, user name, and
password, click this button to automatically find out all the information
of this camera. (such as Camera Channel, Protocol, Vendor, Model)

7. Repeat step 4 through 6 to add other cameras into your list.

2.1.3 Modify the Information of Cameras

1. Open Internet Explorer and login the unit.

17



2. Click IP Camera/ Camera Settings .

3. Click the Camera Settings tab.

4. Click the camera which you want to modify.
5. Modify its information on the top of the page.

Camera Settings

Camera Name

Address

User Mame

Camera Channel

Vander

6. Click the Save button.
7. If you want to replace a camera, click that camera, modify its address,
port, user name, and password, and then click the Save button.

2.1.4 Modify Camera Parameters

Open Internet Explorer and login the unit.

Click IP Camera/ Camera Parameters .

Click the Camera Parameter tab.

Click the camera which you want to modify in the camera list.
Modify its information on the top of the page.

Click the Save button.

o0k wbnNR

Camera Parameter

Camera Name |Location 1

Video Format | (&) Motion JPEG O MPEG4

Frame Rate

Resolution

Compression

Audio | []Enable Audio

Camera Name : the name of this camera.
Video Format : select the format which this camera supports.

18



Frame rate : choose the frame rate.
Resolution : choose the resolution.
Quality : choose the image quality.

Audio : check the Enable Audio option.

Note

The system will adjust the frame rate automatically based on the

maximum frame rate which that camera can support.

2.1.5 View Camera Status

1. Open Internet Explorer and login the unit.

2. Click IP Camera/ Camera Status .
3. Click the Camera Status tab.

Camera Status

eCameraStatus

Index Mame
1 Location 1
Location 2
Location 3

Location 4

Address
192.168.1.60
192.168.1.148
192.168.1.171
192.168.1.203

Conn. Status
Disconnect | Connect
Connected | Dizconnect
Disconnect | Connect
Connected | Dizconnect
Disconnect | Connect
Disconnect [ Connect
Disconnect | Connect

Disconnect | Connect

Rec. Status

Stopped
Stopped
Stopped
Stopped
Stopped
Stopped
Stopped
Stopped

Framerate
0.0 fps
206 fps
0.0 fps
14.51ps
0.0 fps
0.0 fps
0.0 fps
0.0 fps

Bitrate
0.0 Kbps
622.1 Kbps
0.0 Kbps
372.1 Kbps
0.0 Kbps
0.0 Kbps
0.0 Kbps
0.0 Kbps
994.2 Kbps

lite status: normal

Last Update at Fri Jun 06 14:44:39 2008

Conn. Status : the status of the connection. Click the Connect or

Disconnect button to change the connection status.

Rec. Status : the set recording schedule of this camera in this time.
Framerate : frame rate.

Bitrate : transmission bit rate.

19




2.2 Set Recording & Event

2.2.1 Set Recording Mode

P wbh e

Open Internet Explorer and login the unit.

Click Recording & Event / Recording settings

Click the Recording Mode tab.

If selecting Always Recording , the chosen cameras will begin to
record immediately.

Recording Settings

Recording Schedule

® No Recording

O Recording by Schedule

Recording Mode
2 O Always Recording

[Ocamerat [Jcamera2 [Jcamera3 [Jcamera4
[OJcameras [Jcameras [JCamera7 [JCamera8

Autornatic Recycle | []Enable

Keep Video | [] Keep Video |:| Days

No Recording : turn off the recording.

Recording by Schedule : recording by schedule.

Always Recording : turn on the chosen cameras to record always.

Automatic Recycle : check the Enable option to recycle disk space
automatically when the disk space is full.

Keep Video : set a period during which the recorded video clips will
be kept intact.

2.2.2 Set Recording Schedule/ Event

Instead of Always Recording , you can begin the recording by setting
Recording Schedule .

P wbhPE

Open Internet Explorer and login the unit.
Click Recording & Event / Recording settings
Click the Recording Schedule tab.

Check the Day or Week mode.

Day: schedule the cameras to turn the recorder on and off at the

20



same time every day according to your setting.
Week: schedule the cameras for each day of the week differently.

5. Click the schedule of the camera which needs to be modified.
6. Click the column on the bottom of the page.

Recording Settings

Recording Mode S50

Camera List Schedule

@DEYOWE.‘E.‘R 00 01 02 03 C4 O 06 OF €6 CE 10 W 12 "3 W 18 13 17T "8 19 20 21 22 23 M

cameat i e R RN AR

Location 1
Location 2
Location 3
Location 4
Locations
- Camera 6
Camera 7

Camera 8

Insert : insert new schedules.
Delete: delete the selected schedule.
Configure : modify the schedule and recording mode setting.

7. The default setting of the camera’s recording schedule is from 00:00 to

24:00. If you want to modify the time slot, click the Configure button to
modify the default settings first.

21



Schedule Configuration

— Time

Start Time: :
End Time: :
Pre-record EI sec. (Max:

G0)

Post-record EI sec. (Max:
G0)

— Audio
[1Enable audio

Mode
(®) Always Record
) Record on Event

| e || Cancel |

8. Choose the recording mode.

Schedule Configuration

~= Time Mode

Start Time: : O Always Record
End Time: : _@_Fe.cnrd on Event

Mation
Pre-record -
) EI sec. (Max: [ Motion on Location 2
[ Motion on Location 3
Post- d i
ostrecor EI sec. (Max: [ Motion on Location 4
60) : [IMotion on Location 5
— Audio

Digital Input

[1Enable audio

[ClInput #1 on Location 1
[lInput #2 on Location 1
[Input #1 on Location 3
[linput #1 on Location 5

| Ok || Cancel |

Always Record : always record.

Record on Event : record when events triggered. The event can be
triggered by Motion or Digital input .

Note

When setting the event Motion , you need to setup motion
detection function in your camera first.

22



9. If you want to add another new schedule, click the Insert button to add
a new one.

Recording Settings

Recording Mode A
a Recording Schedule
Camera List Schedule o Insert

@Day OWEE"( 00 01 02 03 C4 OF 06 OF C&8 CE 1C 1 12 1 oheeeiw 13 ! ‘B 19 20 1 2 23 M
—-Camera List

Location1
Location2

Location3

Camera 4

Camera 5

Camera 6

Camera 7

Camera 8

Start Time: End Time Record Audio

Uﬂs — U il e o ALKSYS — — Jisw —

: 13:.00 16:00 Always Disable
— i ——— —

10.Repeat step 9 to add other new schedules.
11.Repeat step 5 through step 9 to set other cameras.
12.Click the Save button.

Note
When changing the motion detection settings of a camera, you
need to disconnect the connection between your unit and that
camera first, and then re-connect them to update the settings in
your unit.

Note
When setting an event, Motion or Digital input can be triggered
from other cameras. It means if the system found the motion or
digital input from other cameras, this camera will begin recording.

23



Note
There is another way to set the schedule. If you want to change
the recording time length, drag the time bar from 24:00 back to
the length you wish, and then drag this time bar to the point
which you want to start. (Click the Insert button to add new
schedules too)

Recording Settings

Recording Mode Recon

&) Recording Schedule
Camera List Schedule

N
Uld
@DayOWeek 0001 02 03 C4 5 OB OF (6 CE 1IC 5 7 n 23 b
—-Camera List [~

Location
Location2
Location3
Camera 4
Camera 5
Camera &
Camera 7

Camera 8

Start Time End Time Record

00:00 22:45 Always Disable

Recording Settings
Recording Mode ||

Camera List Schedule

QDayOWeek Drag 00 01 02 0 €4 OF 0B OF OB CE 0 1 12 ‘3 WM 18 7 2R B3N
—-Camera List

Location1
Location2
Location3 N ANEE ANEE NN UNNN UNEN ANEE ANEE
Camera 4
Camera 5
Camera 6

Camera 7 N NN ANEE INEN NN ANEN UREE IR

Camera 8
N ANEN INEN ANEN INEN INEN INNN ERER

Start Time End Time Record Audio
02:45 19:00 Always Disable
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2.2.3 Set Events and Responding Actions

Open Internet Explorer and login the unit.

Click Recording & Event / Event & Action Management
Click the Event & Action tab.

Choose the camera, and then select one of the three events.

P wn PR

Event & Action Management

e Event & Action Management
Camera List Event & Action

Add

-i---LocatioM X
Options
+-Location 2

j—--Location 3

[] connect lost

- [] Motion from Camera
H [] Location 3 Input&0
-;---Location:l
-;---Location 5
-;---Cameraa
-;---Camera'.l’
-fl---CameraB

-i- - System

Connect lost : if the connection between camera and desktop/ laptop
is lost, the action will be triggered.

Motion from Camera : all motions from camera will trigger the action.
Input : external input will trigger the action.

Note
When setting the event Motion from Camera , you need to setup
motion detection function in your camera first.

5. Click the Add button to setup the responding actions of this event.
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Event & Action Management

&) Event & Action Management

Camera List | Event & Action
1

Output i Add

+ Location 1 E-Mail

E Action Qptions
+-Location 2

j—--Location 3

: [] connect lost
[] Motion from Camera
[J Location 3 Input#0
+-Location 4
-;---Location 5
-;---Cameraa
-;---Camera'.l’
-fl---CameraB
-EI---System

Output @ if the event happens, the system will output signal to other
connected devices.
E-Malil: if the event happens, the system will send an E-Mail to the
pre-set contactors.

Click the action, and then click the Configure button to modify the
details of that action if necessary.

Repeat step 4 through 5 to add more actions.

Repeat step 3 through 5 to set more cameras.

Note
In addition to setting cameras, you can also set the event about
the disk space exhausted.

Note
The screen will display the event information when triggered after
selecting any one of them (Connect lost, Motion on the edge,
Digital input).
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2.2.4 Set SMTP Server

1. Open Internet Explorer and login the unit.
2. Click Recording & Event / E-Mail.
3. Click the SMTP Server tab.

Server Address

Sender

Subject ||NVR Event

Motion from Camera 1!!

Body

SUTP
Authentication

User Name

Server Address : SMTP (Simple Mail Transport Protocol) server IP
address.

Sender: sender information.

Subject : subject.

Body : E-Mail content.

SMTP Authentication : provide the user name and password to the
SMTP server for identification before sending E-Mail.

User Name : user name.

Password : password.

2.2.5 Add Event Contactors
1. Open Internet Explorer and login the unit.

2. Click Recording & Event / E-Mail.
3. Click the Contactors tab.
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Delete

Add Contactor : add this new contactor into the contactor list.
Reset: return to the latest saved settings of the contactor list.
Save: save this time modification of the contactor list.

Insert the name of a new contactor.

Insert the E-Mail of this new contactor.

Click the Add Contactor button.

Click the Save button to save this modification of the contactor list.

N o A

2.3 Set RAID & File
2.3.1 View RAID Volume Status

RAID status refers to the disk drives on your unit and how they are
arranged into a RAID Volume.

1. Open Internet Explorer and login the unit.
2. Click RAID & File / RAID Management .
3. Click the RAID Status tab to view the status of your RAID Volume.

RAID Management

RAID-908528

RAID 5 (Striping with parity) (x3)
ity |465.65 GB

Functional

Idle

Mone
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RAID Name: name of your RAID, automatically assigned when it was
created.

RAID Level: RAID 0, 1, 5, or 10, specified when it was created.
Capacity : data capacity of the RAID Volume in GB.

RAID Status : functional is normal. Critical means one disk drive
has failed. Offline means you cannot access your data.

Action Status :idle is normal. Rebuilding means the RAID Volume
is being rebuilt after a disk drive failure. Migrating means the RAID
Volume is adding a disk drive or changing RAID levels.

Background Activity : None is normal. Running means a
background activity is in progress.

2.3.2 View Disk Drive Information

Open Internet Explorer and login the unit.

Click RAID & File / RAID Management .

Click the RAID Status tab.

Click a disk icon to view the disk drive information.

P wnNpRE

RAID Management

= Modify | Delete

Disk Status

Channel 1

Model

5T3250410A3

Firmware Version

3 AAE

Serial No

BRYBTHYMN

Capacity

23289GB

Sectors

63

Heads

16

Cylinders

Ultra DMA Mode

6

FIO Mode Support

4

Smart Support

Yes

Smart Enable

Enable

2.3.3 Migrate a RAID Volume

To migrate a RAID Volume means to change its RAID level or to add disk

drives.

1. Open Internet Explorer and login the unit.
2. Click RAID & File / RAID Management .
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3. Click the Modify tab.

RAID Management

RAID Status plif Create | Delete

© setting

Current Volume |VOLUME1 (RAID-143277) v|
Current RAID Level |RAIDO (Striping) (x1)

Disk(s)in RAID |Channel 1: ST3250410AS 232.89 GB

Migrate to RAID Level |RAIDU (Striping) v|

Assign Disk(s) | Free Diskis) Add Dizkiz) to RAID
Disk 2 (232.89 GB)

<<

4. From the Current Volume dropdown menu, choose the RAID Volume
which needs to be modified.

5. In the Migrate to RAID Level dropdown menu, choose the target RAID
Level.

6. To add disk drives, highlight disk drives in the Free Disks column and

click the >> button to move them to the Disks in RAID column.

Click the OK button to finish it.

™~

With those steps, the RAID Volume is modified as you directed. Migration
requires several minutes, depending on the type of modification taking
place and the size of your disk drives.

During the modification, your RAID Volume and all of the folders on it are
fully accessible.

After the Migration is completed, you must extend the file system so as to
use the storage space you have added. You can extend the file system

immediately or wait until later.

8. Click the RAID & File / File System Management .
9. Click the Extend File System button.
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2.3.4 Create a RAID Volume

In this system, the term RAID Volume refers to one or more disk drives
working together as a RAID logical drive. You must have unassigned disk
drives in your unit to create a new RAID.

1. Open Internet Explorer and login the unit.
2. Click RAID & File / RAID Management .
3. Click the Create tab.

RAID Management

RAID Status Create | Recover

RAID Level || RAIDO (Striping) »

Assign Disk(s) |Free Disk(s) Disk(z) in RAID
Disk 1 (232.89 GB)
Disk 2 (232.89 GB)

>

4. From the RAID Level dropdown menu, choose the RAID level you
prefer for your disk array.

5. Highlight disk drives in the Free Disks column then click the >> button to
move them to the Disks in RAID column.

6. Click the OK button.

The RAID Volume is created and thus formatting begins. Formatting
requires several minutes, depending on the size of your disk drives.

Important
After setting the RAID level and disks, we recommend not to
change the number of disks. You need to re-create the RAID
level when changing the number of disks, which will make your
data lost.
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Note
If you apply Express Mode when using Install Wizard , the disk(s)
2‘ will be set to RAID 1 (2 bay) or RAID 5 (4 bay) automatically. If
you apply Advance Mode when using Install Wizard , the disk(s)
will become the RAID level you set. (See page 12 for more
details)

2.3.5 Designate a Spare Drive
If you have an unassigned disk drive, you can assign it as a spare drive.

Insert the unassigned disk drive.

Open Internet Explorer and login the unit.

Click RAID & File / RAID Management .

Click the Create tab.

From the RAID Level dropdown menu, choose Spare Disk.

a s e

RAID Management

RAID Status C | Recover

RAID Level | RAIDO (Striping) v

Assign Disk(s) |.RAIDO (Stripin Disk(s) in RAID

6. Highlight a disk drive in the Free Disks column and click the >> button to
move it to the Disks in RAID column.
7. Click the OK button.

2.3.6 Delete a RAID Volume
1. Open Internet Explorer and login the unit.

2. Click RAID & File / RAID Management .
3. Click the Delete tab.
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RAID Management

RAID Status | Modify | Delete

) RAID List

Yolume

Disk Mame

RAID Level

Capacity

RAID Status

Action Status

Background Activity

& |VOLUME1

RAID-731802

RAIDO (x1)

23282 GB

Functional

Idle

Mone

oK

Cancel

—

4. Click the option button beside the RAID Volume you want to delete.
5. Click the OK button.
6. In the confirmation box, type “YES” into the field provided, and then

click the OK button.
7. After a RAID Volume is deleted, you need to reboot the unit.

Caution

RAID volume and all the data saved in the folders. Back up any

f When you delete a RAID Volume, you delete all the folders in the

important data before deleting a RAID Volume.

Note

You cannot delete a RAID Volume while a background activity is
running, such as Migration or Rebuild. Wait until these activities
are completed.

2.3.7 View Protocol Status

There are another two ways to access the recorded data in the unit:
through Workgroup or through FTP. Follow the following steps to view the

status of these two ways.

1. Open Internet Explorer and login the unit.
2. Click RAID & File / Protocol Control
3. Click the Information tab.
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Protocol Control

Windows | FTP Sharing

Protocol Action
vingows
FTE Shanng

2.3.8 Modify the Settings of My Network Places Prot  ocol

Open Internet Explorer and login the unit.
Click RAID & File / Protocol Control

Click the Windows tab.

Check and insert the information of this unit.
Click the OK button.

ok wbdPE

Protocol Control

Information FTP Sharing

3
&

Senvices | & Enable O Disable
Computer Name | NV4080_769497

Computer Description | [NV4030

Domain or Workgroup Mame IWO RKGROUP

Services : whether users can access this unit through Windows
Explorer or not.

Computer Name : the name of this unit which is set in the Setup tab
in the Network Setup function.

Computer Description : the name which will be displayed in
Windows Explorer.

Domain or Workgroup Name : the workgroup name of this unit.

2.3.9 Modify the Settings of FTP Protocol

Open Internet Explorer and login the unit.
Click RAID & File / Protocol Control

Click the FTP Sharing tab.

Check and insert the settings of this unit.

P wbdPE
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5. Click the OK button.

Protocol Control

Information Windows

eITI'Sett'llgs

Senices | (& Enable O Disable
Command Port |21
Passive Ports |1024 ~ |55535

Client Coding Type |Eng|ish(Unicode}

(on o (concat

Services : whether users can access this unit through FTP or not.
Command Port : the port for commands between a server and a
client.

Passive Ports : the data transmission port of passive mode.

Client Coding Type : If your FTP client uses double-byte characters
but does not support Unicode, choose your FTP client’'s encoding
from the Client Coding Type dropdown menu.

2.4  Set Network

2.4.1 View Network Status

1. Open Internet Explorer and login the unit.
2. Click Network / Network Setup .

3. Click the Information tab to display the network information of your
unit.

Settings | Live view | Playback | Logout

Network Setup

Setup | Jumbo Frame | Fort Setup

Computer Mame

IP Address

Subnet Mask

Default Gateway IP Address

Primary Domain Mame Server

‘Secondary Domain Mame Server
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2.4.2 Set Network Settings

1. Open Internet Explorer and login the unit.
2. Click Network / Network Setup .
3. Click the Setup tab to setup the network settings of your unit.

Network Setup

Information Jumbo Frame | Port Setup

Computer Mame ]

Internet Protocal | (O Obtain an IP address automatically Specify an IP address

IP Address

Subnet Mask

Default Gateway IP Address

Frimary DNS

Secondary DNS

Computer Name : name your unit.
Note
Because of the internal data modifications, it will spend a while to
Z ‘ change the name of your unit. During this period, you may not
access your unit. You just need to wait a moment, and then
re-access again, instead of rebooting your unit.

Internet Protocol : check whether you want to apply a specific
internet protocol to your unit.

IP Address : IP address of this unit.

Subnet Mask : subnet mask address.

Default Gateway |P Address : gateway IP address.

Primary DNS : primary DNS (Domain Name System) address.
Secondary DNS : secondary DNS address.

4. Click the Jumbo Frame tab to do the maximum transmission settings of
your unit.
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Network Setup

Information | Setup

1000 Mbps

) || 1500 bytes (Default)

Ethernet Link Mode : full duplex or half duplex transmission.
Ethernet Link Speed : transmission speed.

Maximum Transmission Unit : limit the maximum transmission unit.
If the transmission package is larger than the limitation, the system
will divide it into smaller ones when transmitting.

5. Click the Port Setup tab to set the port of your unit.

Network Setup

Information | Setup | Jumbo Frame

2.4.3 Set Network Service
1. Open Internet Explorer and login the unit.

2. Click Network / Server Settings .
3. Click the Live View & Playback Service tab.
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Live Streaming Server
Port: live streaming transmission port.

Maximum Connections: maximum connections from remote
access.

Playback Server
Port: playback transmission port.

Maximum Users: the number of users who can access playback
functions at the same time.
Black/ White List
White List: only IP from the white list is allowed to log in.
Black List: IP from the black list will be blocked.

Note
When setting Maximum Connections in Live Straming Server
settings, 1 connection means that 1 user connects only 1 camera.
If the maximum connections is 16, and each user connects 4

cameras, the allowed connection users will become 4, rather
than 16.
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2.5 Management

2.5.1 View the List of Users

Open Internet Explorer and login the unit.

Click Management / User Management .

Click the Create New Users tab.

The list will be displayed on the bottom of the page.

PN PR

2.5.2 Create New Users

1. Open Internet Explorer and login the unit.
2. Click Management / User Management .
3. Click the Create New Users tab.

4. Insert the user name of this new user.
5. Insert the password of this new user.
6. Choose the group of this user.

: power user can do all the settings except the Network
Settings , RAID Settings , and Management function .
: user just can change his/her password and do the live view and
playback functions.
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7. Select the live view cameras which this user can access.
8. Select the playback channels which this user can access.
9. Click the Create New User button to finish it.

Note
Administrator will be the only user who can apply all the functions.
There is a default administrator account in the system, and you
cannot create a user who is belonged to “Administrator” group.

2.5.3 Modify the Information of Users

Open Internet Explorer and login the unit.

Click Management / User Management .

Click the Modify Users tab.

Click one of the users in the User List on the bottom of this page.

P wnpRE

Change the group of this user.

Select the live view cameras which this user can access.
Select the playback channels which this user can access.
Click the Modify User button to finish it.

© N o o

2.5.4 Change User’s Password

1. Open Internet Explorer and login the unit.
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2. Click Management / User Management .
3. Click the Change Password tab.

Choose the user.

Insert a new password.

Insert this new password again.
Click the OK button.

N o g ks

2.5.5 Delete Users

Except administrator, you can delete any users with the following steps.

Open Internet Explorer and login the unit.

Click Management / User Management .

Click the Modify Users tab.

Click the Delete icon of the user you want to delete.

P wnpRE

5. In the confirmation box, click the OK button.
2.5.6 View Event Log
1. Open Internet Explorer and login the unit.

2. Click Management / Event Log to find the event list of your unit.
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There are three kinds of event will be listed in this page.

: the log information of the operations to your unit,
such as reboot or shutdown.
: the log information of NVR system, such as stop recording
or NVR system start.
: the log information of the “Event & Action
Management”, such as motion detection or camera connection lost.

2.5.7 Save Configuration

Save configuration can let you save the settings of this unit. These settings
can be applied to other units, which will let you set other units more easily.

1. Open Internet Explorer and login the unit.

2. Click Management / Save/ Load Configuration
3. Click the Save Configuration tab.

4. Choose the volume.
5. Choose the folder which the configuration file will be generated into.
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6.
7.
8.

Insert the file name.
Click the OK button.
The configuration file will be generated into the chosen folder.

2.5.8 Load Configuration/ Default Settings

Load configuration can let you apply another unit’s settings into the current
one. Load Default Settings can let your unit back to the default factory

settings.

1. Find your unit through Windows Explorer (insert “\\" plus the IP address
of your unit).

2. Use the administrator’s ID to login.

3. Put the configuration file into the folder “public” in your unit.

4. Open Internet Explorer and login the unit.

5. Click Management / Save/ Load Configuration

6. Click the Load Configuration tab.

7. Check the Load Configuration or the Load Default Settings option. If
choosing Load Default Settings, jump to step 11 directly.

8. Choose the volume.

9. Choose the folder “public”.

10.Insert the file name.
11.Click the OK button.
12.In the confirmation box, type “YES” into the field provided, then click the

OK button.

13.The system will begin to load the settings into your current unit.
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2.6 System

2.6.1 View System Information

1. Open Internet Explorer and login the unit.
2. Click System/ System Information .
3. Click the System Information tab.

The system information includes the following items.

Operating System : embedded Linux

OS Version : OS version

NVR version : NVR system version

CPU: CPU model number

Network Adapter : network type and speed

MAC Address : MAC address of this unit

Network Flow : input/ output network flow

L ocate : the buzzer in the unit will sound to let you know where the
unit is.

2.6.2 View Enclosure Information
1. Open Internet Explorer and login the unit.

2. Click System/ System Information .
3. Click the Enclosure Information tab.
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The enclosure information includes the following items.

: normal range <=5 E :
: normal range >= 1800 RPM
:4.75 V <= normal range <=5.23 V
:11.00 V <= normal range <= 12.94 V
: 3.12 V <= normal range <= 3.46 V
Note
If any value is out of specification, see “Check Enclosure Status”
on page 87.

2.6.3 System Upgrade

1. Find your unit through Windows Explorer (insert “\\" plus the IP address
of your unit).

Use the administrator’s ID and password to login.

Put the upgrade file into the folder “public” in your unit.

Open Internet Explorer and login the unit.

Click System / System Upgrade .

Click the Firmware Upgrade tab.

o g bk wN
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7. Choose the volume.

8. Choose the folder “public”.

9. Insert the entire file name, including the extension name.

10.Click the OK button.

11.The system will begin the upgrade process.

12. After upgrade, the system will reboot. You need to re-access the unit
again.

2.6.4 Set System Date and Time

1. Open Internet Explorer and login the unit.
2. Click System / Date/ Time.
3. Click the Setup tab.

Choose the year.
Choose the month.
Choose the day.
Choose the time.
Click the OK button.

© N o ok
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Caution
When you modify the date or time of the system, the system may
find the wrong data when searching the recorded data. Backup
the recorded data before changing the time.

Note
When you modify the date or time of the system, you need to
reboot when updating.

2.6.5 Adjust the Daylight Saving Time

1. Open Internet Explorer and login the unit.
2. Click System/ Date/ Time.
3. Click the Time Zone tab.

4. Check the Adjust clock for daylight saving changes option.
5. Choose the increment for daylight saving time in your location.
6. Click the OK button.

2.6.6 Enable and Disable the Buzzer

There is a buzzer in the unit. When the unit finishes booting or when a
problem is detected, this buzzer will sound. This buzzer is enabled by
default. You can disable/enable this buzzer with the following steps. (We
recommend that this buzzer should be enabled)

1. Open Internet Explorer and login the unit.

2. Click System/ Buzzer.
3. Click the Setup tab.
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4. Check the Enable or Disable option.
5. Click the OK button.

2.6.7 View UPS Status

If you have an APC Uninterruptable Power Supply (UPS) attached to your
unit, you can check its status with the following steps.

1. Open Internet Explorer and login the unit.

2. Click System/ APC UPS.
3. Click the Information tab.

The Information tab displays the status of the UPS. If there is no UPS
connected or recognized, the Service Status field reports “NO UPS.”

2.6.8 Setup a UPS

This feature enables you to tell your unit how long to run on UPS battery
power and when to shutdown, after a power failure.
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Attach the APC UPS to one of the unit’s USB ports.

Open Internet Explorer and login the unit.

Click System / APC UPS.

Click the Setup tab.

Click the option button beside the shutdown option you want:

a s wbdhPRE

Disable : run until the UPS battery is depleted

System shutdown on the remaining battery percentage > run until
the UPS battery remains this percentage.
System shutdown after the UPS has run on batteries  : run on the

UPS battery for certain period of time.

6. If you choose battery percentage, insert a percentage amount in the %
field.

7. If you choose running time, insert the number of minutes into the Mins.
field.

8. Click the OK button.

2.6.9 Reboot the Unit
1. Open Internet Explorer and login the unit.

2. Click System/ Reboot/ Shutdown .
3. Click the Options tab.
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4. Check the Reboot option.
5. Click the OK button.
6. In the confirmation box, click the OK button.

The rebooting procedure runs automatically. When the unit is fully booted:
The system status LED turns green (right)

The buzzer beeps one time (if the buzzer is enabled)

Note

In rebooting, none of your files will be accessible from your
desktops/ laptops.

2.6.10 Shut Down the Unit

The only time you need to shut down the unit is to replace the disk drive
cooling fan or the power supply. During and after the shutdown, none of
your files will be accessible from your desktops/ laptops.

Open Internet Explorer and login the unit.
Click System / Reboot/ Shutdown .

Click the Options tab.

Check the Shutdown option.

Click the OK button.

In the confirmation box, click the OK button.

L o

1. Press and hold the power button for 5 seconds on your unit’s front
panel.
2. The system status LED will be turned red.
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3. Live view

There are two ways to implement the live view function: through Internet
Explorer or through Remote Live Viewer application.

3.1 Internet Explorer

3.1.1 Live View Control Panel

Log In/ Log Out
(Live view service)

Camera List

PTZ Camera
Control

Snapshot
Remote I/O

Zoom

Information

Digital Zoom  Play/ Stop / Drop Display Window
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PTZ Camera Control : you may control the camera view by utilizing
the PTZ camera control panel to adjust the camera’s view. This is
only available with cameras that support PTZ function.

Zoom : click the + or — button to zoom in or zoom out the view.

Digital Zoom : click the icon or to digital zoom in or digital
zoom out the view.

Play / Stop/ Drop: select a camera/ video and click this button to
play/stop/disconnect a particular channel.

Information Display Window : display video information including
server name, video current status, and bit rate for a selected channel.
Snapshot : select the snapshot function to capture a specific video
image immediately.

Remote /O utilize 1/O device function remotely. - User can remotely
adjust the Output Pins by turning it on or off.

Click to turn on/off

/ the “Output” pins

3.1.2 Setup Live View

P wnpE

Open Internet Explorer and login the unit.

Set the cameras.

Click the Live view button on the top of the page.

Select a camera(s) from the camera list on the right and then drag it to
where you wish the image to be displayed.

52



Important

At the time of running Internet Explorer, not to use the function
“Open in New Window” for browser stability purpose.

3.2 Remote Live Viewer Application
3.2.1 Remote Live Viewer Application Control Panel
: you may control the camera view by utilizing
the PTZ camera control panel to adjust the camera’s view. This is

only available with cameras that support PTZ function.
: click the + or — button to zoom in or zoom out the view.
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Log In/ Log Out
(Server/ Group)

Server and
Camera List

PTZ Camera

/ Control

I
Playback | Snapshot
Remote 1/0
Zoom
I
Exit
Minimize Play/ Stop / Drop Information
Digital Zoom Display Window
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Minimize : minimize the Remote Live Viewer window.

Exit: shut down the application.

Digital Zoom : click the icon or to digital zoom in or digital
zoom out the view.

Play / Stop/ Drop: select a camera/ video and click this button to
play/stop/disconnect a particular channel.

Information Display Window : display video information including
server name, video current status, and bit rate for a selected channel.
Playback : view playback video remotely.

Snapshot : Select the snapshot function to capture a specific video
image immediately.

Remote /O utilize 1/O device function remotely. - User can remotely
adjust the Output Pins by turning it on or off.

Click to turn on/off

/ the “Output” pins

3.2.2 Set Connections to the Units

1. Go to Start > NUUO NVRmini > Remote Live Viewer.
2. Click the Site Setup button.
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3. Insert the unit name.

Insert the IP address.

Modify the port if necessary.

Insert the user name.

Insert the password.

Check the Save Password / Auto Login option.

Click the Test Server button to test the connection between the local
application and the remote unit.

10.Click the Add button to add this unit into your remote server list.

© ©® No g bk
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11.Click the OK button.

3.2.3 Set Groups for Cameras

You can put different cameras into the same group

1. Go to Start > NUUO NVRmini > Remote Live Viewer.
2. Click the Site Setup button.

3. Click the Group tab.
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8.
9.

Log in to all the servers that contain the camera(s) you would like to put
into the group(s).

Click the Insert button to create a new group.

Name this group.

Highlight the camera(s) that you would like to add into this group and
then click the <-- button.

Repeat step 6 to establish the group.

Repeat step 3 through 7 to establish other groups.

10.Click the OK button.

3.2.4 Delete/ Rename Groups for Cameras

No o~ DR

Go to Start > NUUO NVRmini > Remote Live Viewer.

Click the Site Setup button.

Click the Group tab.

Click the group which you want to modify.

Click the Delete or Rename button to remove or rename that group.
Repeat step 3 through 4 to modify other groups.

Click the OK button.

3.2.5 Setup Remote Live View through Application

P wn e

Go to Start > NUUO NVRmini > Remote Live Viewer.

Click the unit you wish to access in your remote server list.

Click the Log In button to access your unit.

Select a camera(s) from the camera list on the right and then drag it to
where you wish the image to be displayed.

58



59



4. Playback

There are two ways to implement the playback function: through Internet
Explorer or through Playback System application.

4.1 Internet Explorer

4.1.1 Playback Control Panel

Browse Mode
Search Mode

Screen Division

Open Record

Setting

Audio Volume
Control

Information Window

FWD/REV:
Forward/ reverse by interval.

Step FWD/REV:
Forward/ reverse frame by frame.

Information Window : display video date and time, cue in/ out points’
time, and speed.

Audio Volume Control : adjust the sound level.

Screen Division : allocate the sub-screen display by clicking on the
desired layout icon. To switch to single camera display, double click a
particular sub-screen. Double click the screen again to regain
previous screen division layout.

Browse Mode : play the recorded video when in Search Mode.
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: click the Open Record button to access the
Date-Time Panel and select the video records which you want to
review.

Calendar View: make the Record Display Window as
calendar view.
List Control: make the Record Display Window as list control.

Play when open: check the option and set the system to start
playing the video clip every time when a record is withdrew.
Auto skip when record motion only mode: check the option to
set up the system to automatically skip to the points where
there were motions recorded.

Next interval: set the interval with which the video goes
forward when you click the Forward button on the control
panel.

Previous interval: set the interval with which the video goes
backward when you click the Reverse button on the control
panel.

Save in clipboard: the image will be saved in the clipboard
and can be pasted on other application software.
Manually save the image file: you can manually select
where you want to save the image, name the saved file,
and choose the format you want to save the image.
Automatically save the image file: by pre-setting a
path/URL and the image format, the system will
automatically save the image accordingly when you click
the Save Image button on the control panel.
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4.1.2 Search the Recorded Video to Playback

Previous/ Next
Recordina Date

Refresh

Record Display
Window

Recording Types

#: refresh the Record Display Window.

Q o O go to previous or next recording date.
Record Display Window : display the available recorded video

records.

Date Time Period : select the start and end time points that indicate
the time period you would like to view after choosing cameras.
Video Preview : check the Enable Preview option to view the
selected video.

Time Table (pre-set recording schedule): click the icon to select
all channels; also click the icon to deselect all channels. Finally,

utilize the scale bar to modify the scale of the

time table; there are two recording modes: Record Always and
Record on Event , and Time Table will display these two modes by
different colors.

Show Records : show the period of recording data in Time Table.

1. From the Record Display Window at the top left of

the Date Time Panel, select the date you want to
search the record from. The red lines shownonthe _ _ - - - — — — _

Video
Preview

Date Time
Period

Time Table

—
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time table indicate available recorded video records.

Use color bars to differentiate recording types from each other. This will
help you select video clips.

Highlight the video clip you want to review by left-clicking and dragging
the time period. You may also utilize the Start Time and End Time in
Date Time Period Section after choosing camera. In addition, modify the
scale of the time table with the icon or on the bottom left.
Check the Enable Preview option to get the preview of the video you
select.

Click the camera name to increase or decrease cameras you want to
playback.

Click the OK button.

Note
The Record Display Window can be shown in (a) calendar view

or (b) list control view. To modify the setting of the record display
window, click the Setting button at the right of the page. See
page 61 for more details.

4.1.3 Play the Recorded Video

AR A

Be sure that you have set the schedule/ recording event first.

Open Internet Explorer and login the unit.

Click the Playback button on the top of the page.

Click the Open Record button.

The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from. See
page 62 for more details about the Record Display Window.

Highlight the video records that you want to review. See page 63 for
more details.

. Click the OK button.

4.1.4 Smart Search from the Recorded Video

After opening the recorded video, click the Search Mode button to obtain
the Intelligent Search Tool panel. You can search unusual events during the
recoding period.

63



There are 5 types of unusual events: General Motion , Foreign Object,
Missing Object, Lose Focus, and Camera Occlusion .

: detect all movements in the
defined area.

1. Define detection zone by dragging to draw a
detection zone. You may define more than one
zone by repeating this step.

2. Modify the sensitivity setting by changing the
slider control. Moving toward right will increase
the sensitivity level, which means a relatively
small movement will trigger the alarm.

3. Set the interval. Moving toward right will increase
time interval so that the alarm will only be
triggered when the movement lasts longer.

4. Check the Stop when found option. If uncheck, the search tool will list

all the events it found, instead of stopping at the moment the event
found.
5. Click the Search button.

- alarm is set on when any additional object appears
in the defined area on the screen.

Define detection zone by dragging to draw a detection zone.
Modify the sensitivity setting.
Set the Interval.

P wn e

all the events it found, instead of stopping at the moment the event
found.
5. Click the Search button.

Check the Stop when found option. If uncheck, the search tool will list

- alarm is set on when the selected object is removed

from the defined area on the screen.

1. Define detection object by dragging to draw a detection zone.
2. Modify the sensitivity setting.
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Set the Interval.

Check the Stop when found option. If uncheck, the search tool will list
all the events it found, instead of stopping at the moment the event
found.

Click the Search button.

: system will inform you when the camera(s) lose its
focus.

: alarms when the camera is blocked.

4.1.5 Recorded Video Enhancement

P wnNpE
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Open Internet Explorer and login the unit.

Click the Playback button on the top of the page.

Click the Open Record button.

The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from.
Highlight the video clip you want to review, and then click the OK button.
Click the Enhancement button.

Check the General Setting.

: the settings will be only
applied to the selected channel.
the settings will be only
applied to those currently shown on the screen.

Set the Filter Setting.

: check the option and adjust the gamma
value of the image to enhance the image and
make it cleaner.

: check the option to activate the function. Move the slider
control to the right to sharpen the image, to the left to soften it.

: check the option to activate the function. Move the slider

control to the right to make the image brighter.

: check the option to activate the function. Move the slider
control to the right to increase contrast.
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: check the option to show the record in grey scale mode
so the image displays in black and white.

9. Click the OK button.

: stop the enhancement function and close the enhancement
tool. (The system will automatically back to the default settings.)
: back to the default settings, however, the enhancement tool
still works.
. apply the modifications of the settings.

4.1.6 Save Video

Open Internet Explorer and login the unit.

Click the Playback button on the top of the page.

Click the Open Record button.

The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from.
Highlight the video clip you want to review, and then click the OK button.
Choose the camera display that you want to save as a video clip.
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7. Set up the cue in and cue out points; the cue in and cue out time will be
shown on the information window.

8. Click the Save Video button.
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9.

Choose the folder where you want to save the file at.

10.Insert the file name and click the Save button.
11.Choose the export format.

12.Choose the use profile.

13.Check the Export Audio option.

14.Click the OK button.

Note
We recommend you to export to the .asf format when saving
video. In exporting to the .avi format, the frame rate will be
increased when playing in the video player.

4.1.7 Save Image
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8.
9.

Open Internet Explorer and login the unit.

Click the Playback button on the top of the page.

Click the Open Record button.

The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from.
Highlight the video clip you want to review, and then click the OK button.
Choose the camera display that you want to save pictures.

Click the Save Image button when the image you want is shown on the
screen.

Choose the folder where you want to save the file at.

Choose the folder and the format of image (BMP or JPEG) you prefer.

10.Insert the file name.
11.Click the Save button.

Note
You may skip step 3 by pre-setting a folder and format what you
want to save the images. See page 61 for more details.

4.1.8 Print Image

Print the current image of the video you choose.
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Open Internet Explorer and login the unit.

Click the Playback button on the top of the page.

Click the Open Record button.

The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from.
Highlight the video clip you want to review, and then click the OK button.
Choose the camera display that you want to print pictures.

Click the Print button when the image you want is shown on the screen.
Set print settings.

PN e
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: check to have the image print in original
size.
: check to have the image fit the page.
: top, center, or bottom
. print the image from currently selected channel or all
the channels shown on the screen.

9. Click the Print button.
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4.1.9 Backup the Recorded Video

Different from Save Video, the Backup function will save all the recorded
videos which belong to the time slot you set, instead of the clips.

1. Open Internet Explorer and login the unit.
2. Click the Open Record button to select data.
3. Click the Backup button.

Set the Start Time and End Time you want to backup.
Select the cameras you want to backup.

Select the directory you want to save the backup data.
Click the Backup button.

The system will then begin backup process automatically.

© N o o bk
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4.2 Remote Playback System Application

4.2.1 Playback System Application Control Panel

The Playback System control panel is similar to the playback panel in
Internet Explorer. See page 60 for more details about those buttons.

Browse Mode
Search Mode

Screen Division
Open Record

Setting

Audio Volume
Control

FWD/REV: Information Window

_ Customize the speed on
Step FWD/REV: Setting panel_

Forward/reverse frame by
frame. 0



4.2.2 Set Connections to the Units

Before using Playback System application, you need to set a connection
to your unit first.

1. Go to Start > NUUO NVRmini > Playback System.
2. Click the Remote Server button.

Insert the name of your unit.

Insert the IP address of that unit.

Modify the port if necessary.

Insert the user name.

Insert the password.

Check the Save Password option.

Click the Test Server button to test the connection between the local
application and the remote unit.

10.Click the Add button to add this unit into the remote server list.
11.Click the OK button.

© ©® N bk ow
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4.2.3 Search the Recorded Video to Playback

Remote
Playback Site
Management

Go to Start > NUUO NVRmini > Playback System.

2. Click the Open Record button.

Click the icon on the top of the Date-Time Panel to obtain the

Remote Playback Site Management dialog, and then select the server
you want to access.

Highlight the records you want to view in the Time Table.

Set the Date Time Period.

The search process in Playback System application is similar to that of
Internet Explorer. See page 62 for more details about the setting process.

4.2.4 Play the Recorded Video

Be sure that you have set the schedule/ recording event first.

2. Go to Start > NUUO NVRmini > Playback System.

Click the Remote Server button to set connections to your unit. See
page 71 for more details.

Click the Open Record button.

The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from. See
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page 62 for more details.

6. Highlight the video records that you want to review. See page 63 for
more details.

7. Select the start and end points in Date Time Period to adjust the time
slot.

8. Click the OK button.

4.2.5 Smart Search from the Recorded Video

1. Go to Start > NUUO NVRmini > Playback System.

2. Click the Open Record button.

3. The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from. See
page 62 for more details.

4. Highlight the video records that you want to review. See page 63 for
more details.

5. Choose the camera display that you want to implement smart search.

6. Click the Search Mode button to obtain the Intelligent Search Tool
panel.

7. Setup unusual events here to detect abnormality occurred during the
recoding period. See page 64 for more details.

8. The searched events will be listed. Click to find that event.

There are 5 types of unusual events: General Motion , Foreign Object ,
Missing Object , Lose Focus , and Camera Occlusion .

. detect all movements in the defined area.

. alarm when any additional object appears in the
defined area on the screen.

: alarm when the selected object is removed from the
defined area on the screen.

: system will inform you when the camera(s) lose its
focus.
: alarm when the camera is blocked.

The smart search in Playback System application is similar to that of
Internet Explorer. See page 64 for more details.
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4.2.6 Recorded Video Enhancement

1. Go to Start > NUUO NVRmini > Playback System.

2. Click the Open Record button.

3. The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from. See
page 62 for more details.

4. Highlight the video records that you want to review. See page 63 for
more details.

5. Choose the camera display that you want to implement video
enhancement.

6. Click the Enhancement button.

7. Check the General Setting.

: the settings will be only applied to the
selected channel.
the settings will be only applied to those
currently shown on the screen.

8. Set the Filter Setting.

check the option and adjust the gamma value of the image
to enhance the image and make it cleaner.
check the option to activate the function. Move the slider
control to the right to sharpen the image, to the left to soften it.
check the option to activate the function. Move the slider
control to the right to make the image brighter.
check the option to activate the function. Move the slider
control to the right to increase contrast.
check the option to show the record in grey scale mode
so the image displays in black and white.

9. Click the OK button.
: stop the enhancement function and close the enhancement
tool. (The system will automatically back to the default settings.)

: back to the default settings, however, the enhancement tool
still works.
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. apply the modifications of the settings.

4.2.7 Save Video

1. Go to Start > NUUO NVRmini > Playback System.

2. Click the Open Record button.

3. The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from. See
page 62 for more details.

4. Highlight the video records that you want to review. See page 63 for
more details.

5. Choose the camera display that you want to save as a video clip.

6. Set up the cue in and cue out points; the cue in and cue out time will
show on the information window.

7. Click the Save Video button.

8. Choose the folder where you want to save the file at.
9. Insert the file name and click the Save button.
10.Choose the export format.

11.Choose the use profile.

12.Check the Export Audio option.

13.Click the OK button.

4.2.8 Save Image

1. Go to Start > NUUO NVRmini > Playback System.

2. Click the Open Record button.

3. The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from. See
page 62 for more details.

4. Highlight the video records that you want to review. See page 63 for
more details.
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7.
8.
9.

Choose the camera display that you want to save pictures.

Click the Save Image button when the image you want is shown on the
screen.

Choose the folder where you want to save the file at.

Choose the format of image (BMP or JPEG) you prefer.

Insert the file name.

10.Click the Save button.

Note
You may skip step 7 by pre-setting a folder and format what you
want to save the images. See page 61 for more details.

4.2.9 Print Image

Print the current image of the video you choose.

Go to Start > NUUO NVRmini > Playback System.

2. Click the Open Record button.

The Record Display Window will show the information of the available
video clips. Select the date you want to search the record from. See
page 62 for more details.

Highlight the video records that you want to review. See page 63 for
more details.

Choose the camera display that you want to print pictures.

Click the Print button.

Set the print settings.

: select to have the image print in original
size.
: select to have the image fit the page.
: top, center, or bottom
. print the image from currently selected channel or all
the channels shown on the screen.
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4.2.10 Backup the Recorded Video

Different from Save Video, the Backup function will save all the recorded
videos which belong to the time slot you set, instead of the clips.

Go to Start > NUUO NVRmini > Playback System.
Click the Open Record button to select data.

Click the Backup button.

Set the Start Time and End Time you want to backup.
Select the cameras you want to backup.

Select the directory you want to save the backup data.
Click the Backup button.

No s~ DR
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5. Backup and Delete the Records
5.1 Backup the Recorded Video through Application

In addition to the ways mentioned in the previous chapters, you can apply
the application to backup your files.

1. Go to Start > NUUO NVRmini > Backup System.
2. Insert the IP address of your unit.

Insert the user name.

Insert the password.

Click the OK button.

Click the New Period button.

o g bk w
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7. Select the record date.

8. Set the Start Time and End Time you want to backup. (or highlight the
video records which you want to backup)

9. Select the cameras you want to backup.

10.Click the OK button.

11. Select the time slot which you want to backup.
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12.Click the Backup button.

13. Select the way and directory you want to save the backup data.

14.Check the Include Playback application  option, which will add
Playback application into the backup folder.

15.Click the OK button.

5.2 Backup the Recorded Video through Windows
Explorer

1. Find your unit through Windows Explorer (insert “\\" plus the IP address
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of your unit)
2. Insert the name and password of the administrator or power user.
3. Open the “videodata” folder.
4. Copy the date folder which you want to backup to you desktop/ laptop.

5.3 Backup the Recorded Video through FTP

1. Find your unit through Windows Explorer (insert “ftp://” plus the IP
address of your unit)

2. Insert the name and password of the administrator or power user.

3. Open the “videodata” folder.

4. Copy the date folder which you want to backup to you desktop/ laptop.

5.4 Playback the Backup Records

5.4.1 Backup with Playback Application

1. Apply Backup System application to backup your records.

2. Check the Include Playback application option, which will add
Playback application into the backup folder.

3. Open that folder.

4. Double-click the Playback application icon.

5. Select the recorded data to playback.

5.4.2 Backup without Playback Application

1. Apply Playback function to backup your records.

2. Put your backup folder into the program folder of NVRmini. (Default
directory is “C:\Program Files\NUUO\NVRmini".)

3. Go to Start > NUUO NVRmini > Playback System.

4. Click the Open Record button.

5. Select the recorded data to playback

5.5 Delete the Recorded Video

1. Find your unit through Windows Explorer (insert “\\" plus the IP address
of your unit).
2. Use the administrator’s ID and password to login.
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3. Open the “videodata” folder.
4. Select the date folder which you want to delete.
5. Delete the folder.

Caution

In order to let the system be stable, do not delete the recorded
data of the day in which you do the delete process.
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6. Logout

Click the Logout button on the top of the page to logout the system.
Meanwhile, if there is no action in 10 minutes, the system will logout
automatically to avoid the access from other people.

7. Remote PC System Requirement

The minimum system requirement of the remote PC is as the following.

Remote PC Minimum Requirements

Model 2 bay (4 channels) 4 bay (8 channels)
OS Supported | Windows 2000/ XP/ 2003/ Vista

CPU Pentium 4 — 2.4 GHz Pentium 4 — 2.8 GHz
RAM 512 MB

User Interface | 1. HTTP Web browser - Internet Explorer v6 or later
2. Client Application Program
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8. Troubleshooting
8.1 Check the System Status LED

The system status LED reports the condition of the enclosure fan and
power supply:

: normal enclosure function
: there is a problem with the fan or power supply
: the fan, power supply, or file system has failed

If your unit is configured to work with a UPS, it will continue to run a while
after a power supply failure.

8.2 Check Disk Status LEDs

The disk status LEDs report the condition of the disk drives:

: normal disk drive function
: rebuilding to this disk drive
: failed disk drive
: no disk drive is installed

8.3 Replace a Failed Disk Drive

If a disk drive fails, the Disk Status LED becomes red. If the disk drive
belongs to a RAID Volume, the Volume goes Critical or Offline. See “Check
RAID Volume Status” on page 85.

Replace the failed disk drive with a new disk drive of the same or slightly
greater capacity. You do not have to power down the unit.

Open the unit’s front lid.

Pull out the drive carrier with the failed drive.

Remove the failed disk drive from the drive carrier.

Install a new disk drive into the carrier.

Place the carrier with the new disk drive back into the open slot in the
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unit.

If the failed drive belonged to a RAID Volume, the RAID Volume will begin
rebuilding as soon as the new drive is installed. During the Rebuild, the
Disk Status LED shows amber. When the Rebuild is finished, the Disk
Status LED turns green.

If the replacement drive is free, i.e., not assigned to a RAID Volume or as a
spare, the Disk Status LED remains dark after you install the new drive.

8.4 Check RAID Volume Status

1. Click RAID & File/ RAID Management .
2. Click the RAID Status tab.

8.5 Respond to a Critical RAID Volume

How the unit responds to a Critical RAID Volume depends on the RAID
level of your Volume and whether you have a spare drive available:

For a RAID 1 Volume or a three-drive RAID 5 Volume, if a spare drive
is available, the RAID Volume begins rebuilding itself automatically.
For RAID 1, 5, and 10 Volumes, when no spare drive is available, you
must replace the failed disk drive. The RAID Volume will begin
rebuilding itself when you install the new disk drive. See “Replace a
Failed Disk Drive” on page 84.

RAID 0 Volumes go offline after a disk drive failure. A RAID 0 Volume
cannot be rebuilt. All data on the Volume is lost.

8.6 Respond to an Invalid RAID Volume

The system considers a RAID Volume invalid when the RAID Volume was
created by a different unit. However, the RAID Volume itself remains
functional and the data on it is safe.

When the system does not recognize the RAID Volume, the unit displays
the RAID Volume as invalid.
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Use the Recover function to validate the RAID Volume. The Recover tab is
only active when an invalid RAID Volume is present and can be recovered.
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Open Internet Explorer and login the unit.

Click RAID & File / RAID Management

Click the Recover tab.

On the Recover tab, click the option button beside the invalid RAID
Volume.

Click the OK button.
The unit will reboot to update its configuration and recognize the RAID
Volume.

Important
Running the Recover function might erase some or all of your
settings. If that condition happens, run Install Wizard to set them
again.

8.7 Check File System Status

Typically the first indication of a problem with the unit’s file system is when
your drive becomes unavailable.

P wnpE

Open Internet Explorer and login the unit.

Click RAID & File / File System Management .

Click the File System Status tab.

Look for the RAID Volume icon E&. If the RAID Volume icon is Critical

i (has a yellow “1"), the file system contains errors and you must
rebuild the file system.

8.8 Rebuild the File System

Open Internet Explorer and login the unit.

2. Click RAID & File / File System Management .

Click the File System Status tab.

Click the RAID Volume Critical icon E# to display the Rebuild File
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System button.

Click the Rebuild File System button.

In the confirmation box, type “YES” into the field provided, and then
click the OK button.

8.9 Check Enclosure Status

PN PR

Open Internet Explorer and login the unit.
Click System / System Information .
Click the Enclosure Information tab.

If CPU temperature is above specification:

Be sure there is adequate air flow around the device.
Be sure the ambient temperature is below 35T (95F) .

Check the fan speed.

If the fan speed is below 1800 RPM, contact Technical Support.
If any power status is out-of-specification, contact Technical Support.

8.10 Restore the Default Administrator’'s Password

If you forget the password, and want to reset the Administrator’s password
to the default password: admin , follow the following steps.

Verify that the system is fully booted.

. Insert your reset tool into the reset button hole on the back of the

device.

Press and hold the reset button for 8 seconds, until the System Status
LED flashes three times.

The Administrator’s password is now reset to admin .

Caution
Press and hold the reset button for 8 seconds will restore the
password of the Administrator. Press and hold the reset button
for 14 seconds, the unit will restore the default settings.
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Caution
When you reset or recover your unit, sometimes it will cause data

broken. Backup your recorded data before resetting or
recovering your unit.

8.11 Install ActiveX

If you cannot see the complete page of the system when using Internet
Explorer, maybe it's because the ActiveX installation process is not
completed.

1. Open Internet Explorer and login the unit.

2. Click the Live view / Playback button on the top right.
3. The browser will ask whether to install ActiveX.

4. Click the upper bar to begin the installation process.
5. Click the Install button to complete the process.

8.12 Upgrade Process When Applying Windows Vista

Windows Vista limits some authorities of users, which will reject the
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connection through Windows Explorer. In this condition, you need to
change the settings of Vista first.
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7.
8.
9.

Go to Start >Control Panel.

Select Administrative Tools.

Select Local Security Policy/ Security Options.

Select “Network security: LAN Manager authentication level”.

From the dropdown menu, choose “Send LM & HTLM — use NTLMv2
session security if negotiated”.

Find your unit through Windows Explorer (insert “\\” plus the IP address
of your unit).

Use the administrator’s ID and password to login.

Put the update file into the folder “public” in your unit.

Open Internet Explorer and login the unit.

10.Click System / System Upgrade .
11.Click the Firmware Upgrade tab.
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12.Choose the volume.

13.Choose the folder “public”.

14.Insert the entire file name, including the extension name.

15.Click the OK button.

16.The system will begin the upgrade process.

17. After upgrade, the system will reboot. You need to re-access the unit
again.

8.13 Cannot Playback When Applying Windows 2000

1. Check whether you have installed Media Player or not.
2. If you have installed Media Player, check whether its version is version
9 or later.

8.14 Cannot Login the Unit through Internet Explore  r

1. Check the settings of your antivirus software.
2. Change to appropriate settings or turn off this antivirus software.
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Appendix — RAID System
Introduction to RAID

RAID (Redundant Array of Independent Disks) allows multiple disk drives
to be combined together into a RAID Volume. You will create a RAID
Volume on your unit when you perform the setup procedure.

The benefits of a RAID can include:
Higher data transfer rates for increased server performance
Increased overall storage capacity for a single Volume
Data redundancy/fault tolerance for ensuring continuous system
operation in the event of a disk drive failure

Different RAID levels use different organizational models and have varying
benefits. Also see “Choose a RAID Level” on page 94. The following outline
breaks down the properties for each RAID level supported on this unit:

RAID 0 — Stripe

When a RAID Volume is striped, the read and write blocks of data are
interleaved between the sectors of multiple disk drives. Performance is
increased, since the workload is balanced between drives or “members”
that form the RAID Volume. Identical drives are recommended for
performance as well as data storage efficiency.

The RAID Volume’s data capacity equals the capacity of the smallest disk
drive times the number of disk drives. For example, one 100 GB and three
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120 GB drives will form a 400 GB (4 x 100 GB) RAID Volume instead of
460 GB.

If disk drives of different capacities are used, there will also be unused
capacity on the larger drives.

Because RAID 0 does not offer Fault Tolerance, meaning that you cannot
recover your data after a disk drive failure, we does not recommend a RAID
0 Volume for your unit.

RAID 0 Volumes on this unit consist of one or more disk drives.

RAID 1 — Mirror

When a RAID Volume is mirrored, identical data is written to a pair of disk
drives, while reads are performed in parallel. The reads are performed
using elevator seek and load balancing techniques where the workload is
distributed in the most efficient manner. Whichever drive is not busy and is
positioned closer to the data will be accessed first.

With RAID 1, if one disk drive fails or has errors, the other mirrored disk
drive continues to function. This is called Fault Tolerance. Moreover, if a
spare disk drive is present, the spare drive will be used as the replacement
drive and data will begin to be mirrored to it from the remaining good drive.

The RAID Volume’s data capacity equals the smaller disk drive. For
example, a 100 GB disk drive and a 120 GB disk drive have a combined
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capacity of 100 GB in a mirrored RAID Volume.

If disk drives of different capacities are used, there will also be unused
capacity on the larger drive.

RAID 1 Volumes on this unit consist of two disk drives.

If you want a mirrored RAID Volume with more than two disk drives, see
“RAID 10 — Mirror / Stripe” on page 94.

RAID 5 — Block Striping with Distributed Parity

RAID 5 organizes block data and parity data across the disk drives.
Generally, RAID level 5 tends to exhibit lower random write performance
due to the heavy workload of parity recalculation for each 1/0. RAID 5
works well for file, database, application and web servers.

The capacity of a RAID 5 Volume equals the smallest disk drive times the
number of disk drives, minus one. Hence, a RAID 5 Volume with four 100
GB disk drives will have a capacity of 300 GB. A RAID Volume with two 120
GB disk drives and one 100 GB disk drive will have a capacity of 200 GB.

RAID 5 is generally considered to be the most versatile RAID level.

RAID 5 requires a minimum of three disk drives.
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RAID 10 — Mirror / Stripe

Mirror/Stripe combines both of the RAID 0 and RAID 1 types. RAID 10 can
increase performance by reading and writing data in parallel while
protecting data with duplication. At least four disk drives are needed for
RAID 10 to be installed. With a four-disk-drive RAID Volume, one drive pair
is mirrored together then striped over a second drive pair.

The data capacity RAID 10 Volume equals the capacity of the smallest disk
drive times the number of disk drives, divided by two.

In some cases, RAID 10 offers double fault tolerance, depending on which
disk drives fail.

RAID 10 Volumes on this unit consist of four disk drives.

Because all of the available disk drives are used for the RAID Volume, you
cannot set up a spare drive with RAID 10.

Choose a RAID Level

There are several issues to consider when choosing the RAID level. The
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following summarizes some advantages, disadvantages and applications
for each choice.

RAID O
Advantage Disadvantage
Implements a striped disk RAID Not a true RAID because it is not fault
Volume, the data is broken down into tolerant
blocks and each block is written to a The failure of just one drive will result
separate disk drive in all data in an RAID Volume being
I/O performance is greatly improved lost
by spreading the I/O load across many Should not be used in mission critical
channels and drives environments
No parity calculation overhead is
involved
RAID 1
Advantage Disadvantage
Simplest RAID storage subsystem Very high disk overhead - uses only
design 50% of total capacity

Can increase read performance by
processing data requests in parallel
since the same data resides on two

different drives

RAID 5
Advantage Disadvantage
High Read data transaction rate Disk failure has a medium impact on
Medium Write data transaction rate throughput

Good aggregate transfer rate

Most versatile RAID level
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Advantage Disadvantage

Implemented as a mirrored RAID Very high disk overhead — uses only
Volume whose segments are RAID 0 50% of total capacity
RAID Volumes

High I/O rates are achieved thanks to

multiple stripe segments

Spare Drive

A spare is a disk drive that has been designated to replace a failed disk
drive in a RAID Volume. In the event of the failure of a disk drive within a
RAID 1 or three-drive RAID 5 Volume, the spare drive is activated as a
member of the RAID Volume to replace a disk drive that has failed.

A spare drive cannot replace the failed drive in a RAID 0 Volume because
of the way in which data is written to the disk drives under RAID 0.

A spare drive is not available for a RAID 10 Volume because RAID 10
requires all four disk drives in the unit enclosure. However, when you
replace the failed disk drive, the unit will automatically rebuild the RAID

Volume using the new disk drive.

You must designate a disk drive as a Spare. Use the system to designate
the Free disk drive as a Spare.

Maintaining a spare drive is a good precaution to protect your RAID Volume
integrity in the event of disk drive failure.

Automatic Rebuilding

When a disk drive in your RAID 1, 5, or 10 Volume fails, and a replacement
disk drive becomes available, the RAID Volume will rebuild itself to the new
disk drive automatically.

For RAID 1 and three-drive RAID 5 Volumes, you can designate a spare
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drive. If a spare drive is present when the RAID Volume experiences a disk
drive failure, the rebuild will start automatically using the spare drive.

For RAID 1, RAID 5, and RAID 10 Volumes without a spare drive, the RAID
Volume will begin to rebuild itself automatically when you remove the failed
disk drive and install a new disk drive.

A RAID 0 Volume cannot be rebuilt because of the way in which data is
written to the disk drives under RAID 0. Even if there is a designated spare
drive, rebuilding is not possible for RAID 0 Volumes.

RAID Volume Migration

Migration is the process of:
1. Change the RAID level
2. Add disk drives but keep the same RAID level

In the migration process, the existing RAID Volume is called the Source.
The proposed RAID Volume is called the Target. Each target RAID Volume
has certain requirements and they are different for each RAID level. You
must meet all of the requirements in order to successfully migrate a RAID
Volume.

In most cases, you must add one or more disk drives during the migration
process. You can never reduce the number of disk drives.

While the migration is running, you can still access the folders on your
RAID Volume and the data they contain.

The following tables show the migration options for a source RAID Volume

according to its RAID level. The available target RAID levels are shown
with their requirements.
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RAID O

A RAID 0 source Volume can migrate to the following target RAID levels:

Target Requirement
RAID O | Add disk drives.
RAID 1 | 2 disk drives only.
Only a 1-drive RAID 0 can’t migrate to RAID 1. Add 1 disk drive.
RAID 5 | 3 disk drives minimum.
At least 1 more disk drive than the RAID 0 RAID Volume.
RAID 1

A RAID 1 source Volume can migrate to the following target RAID levels:

Target Requirement
RAID O | Can use same number of disk drives.
RAID 5 | 3 disk drives minimum.
At least 1 more disk drive than the RAID 1 RAID Volume.
RAID 5

A RAID 5 source Volume can migrate to the following target RAID levels:

Target Requirement
RAID O | Can use the same number of disk drives.
RAID 5 | Add a disk drive.

RAID 10

A RAID 10 source Volume cannot migrate or add more disk drives.

98




